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1

Accessing the Virtual Lab
1. Launch a web browser application.

2. Load the IrYdium website:
http://ir.chem.cmu.edu/irProject/applets/virtualLab/
You may receive a new URL from your professor.

3. In the list located on the left side of the window, click the “applet”
link.
If the applet does not run initially, you may need to download additional
components for your browser. Refer to the online instructions for
platform-specific procedures.
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Loading Homework
Note: You may want to begin with the Demonstration problem (in the
Local Repository) and the accompanying handout for a brief overview
of features.

1. In the File menu, select the Load Homework... option.
A Load Homework dialogue box will appear.

2. Double click to select your class from the available repositories
in the left panel.
After connecting to the repository, a list of available problems will
be displayed in the right panel.

3. Select your homework problem and click Ok.
The dialogue box will disappear and you will see a new cabinet in
the Stockroom Explorer window on the left of the workbench. A
problem description and all the relevant solutions for that problem
will appear in the new cabinet.
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Obtaining Glassware
1.

In the action bar on the left side of the workbench, click the Obtain
Glassware button.
A menu of glassware options will be displayed.

2.

Drag the pointer down to the type of glassware you want and
single click.
The menu will disappear and the new glassware will appear on the
workbench.
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Obtaining a Bunsen Burner
1.

On the action bar located on the left side of the workbench,
click the Obtain Tools button.
A menu of tool options will be displayed.

2.

Select Bunsen Burner from the menu.
A Bunsen burner will appear on your workbench.
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Obtaining a Solution
1.

In the Stockroom Explorer window, double click on the IrYdium
Solutions cabinet to open it.
A list of cabinets containing solutions will be displayed. Double click
on the cabinet from which you want to retrieve a solution.

2. Double click on the solution you want to add to your workbench.
An Erlenmeyer flask containing 100 mL will appear on your workbench, labeled with the name of the solution.
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Selecting a Transfer Mode
Note: You should use realistic transfer mode to simulate the precision
possible in an actual lab, and precise mode to check calculations.

1.

In the Tools menu, drag the pointer down to Transfer Bar.
A submenu will appear.

2.

Select either Precise Transfer or Realistic Transfer.
The submenu will disappear, and the transfer bar below the
workbench will reflect the selected transfer mode.

Precise transfer mode includes a Transfer Field where you can
type a number with several significant figures.

Realistic transfer mode includes a button that pours only when the
button is held down.

Note: Solutions pour faster from larger glassware. The Realistic
Transfer Bars have marks to show how fast the transfer is occurring.
Only 0.02mL is transferred when the purple bar stays within the
“drop” range, marked on the left of the transfer bar when using a
pipette or buret.
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Pouring a Solution
Note: Use this method to transfer solutions using flasks, beakers, and burets.

Realistic Transfer:
1. Click the flask you want to pour from (your source solution).
The name of the flask will become highlighted.

2. Drag the source solution on top of the flask you want to pour the
solution into (your recipient flask) so that the pieces of glassware
overlap.
The source solution will become tilted above the recipient flask and the
name of the recipient flask will become highlighted.
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3.

In the Transfer Bar below the workbench, click and hold the Pour
button for as long as you wish to pour source solution into the
recipient flask.
As you hold the Pour button, the amount of source solution actually
poured is shown in the bar to the left of the Pour button. This
counter resets itself each time you click on the Pour button. Refer
to the Solution Information window to determine the total amount of
solution in the recipient flask or click on the source solution and
refer to the Solution Information window to determine the remaining
amount of solution in the source flask. All changes in the concentration or pH are updated after releasing the Pour button.

Precise Transfer:
Follow Steps 1 and 2 for Realistic Transfer, but instead of holding down
the Pour button, type in the volume and click on the Pour button once.

3. In the Transfer Field below the workbench, type the amount of
source solution (in mL) you want to pour into the recipient flask
and press Enter.
In the Solution Information window, the volume of the recipient flask
will increase to reflect its new volume. If you single click on the
source flask, you can see an equivalent decrease in the volume of
the source solution. All changes in the concentration or pH are
updated after you click the Pour button.
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Transferring with a Pipette
Realistic Transfer:
1.

Click and drag the flask you want to draw solution from (your
source solution) on top of the pipette so the pieces of glassware overlap.
The detailed view of the pipette will appear.

2.

In the Transfer Bar field located beneath the workbench, click the
Withdraw button for as long as you wish to withdraw solution
from the source flask into the pipette.
In the Solution Information window, the volume of the pipette will
increase to reflect its new volume. If you single click on the source
flask, you can see an equivalent decrease in the volume of the
source solution. All changes in the concentration or pH are updated
after you release the Withdraw button.

3.

Single click and drag the pipette on top of the flask you want to
add the solution to (the recipient flask).
The detailed view will still be shown.
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4.

In the Transfer Field below the workbench, click the Pour
button for as long as you wish to release solution from the
pipette into the recipient flask.
In the Solution Information window, the volume of the pipette will
decrease to reflect its new volume. If you single click on the
recipient flask, you can see an equivalent increase in the volume of
the recipient solution. All changes in the concentration and pH are
updated after releasing the Pour button.

Precise Transfer:
Follow steps 1 and 3 for Realistic Transfer but instead of
holding down the Pour button, follow the steps below:

2.

In the Transfer Bar below the workbench, type the amount of
source solution (in mL) you want to withdraw with the pipette
and press Enter.

4. In the Transfer Bar below the workbench, type the total volume of
the pipette to transfer its contents to the recipient flask and
press Enter.

Note: The detailed view of pipettes and burets automatically displayed
during a transfer can be viewed any time by right clicking on the
glassware and selecting Detail View from the pop-up menu.
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Obtaining Solution Information
1. Click on the solution about which you want to obtain information.
The flask will become highlighted.The Solution Info panel to the right of
the workbench will show the name, volume, concentration, temperature, and pH of the selected solution.
Your instructor may disable some of the features in the Solution Info
panel for certain assignments.

2. In the Solution Info panel to the right of the workbench, click on the
circle next to the state of species (aqueous, solid, gas) you wish
to view.
The concentration viewer, located beneath the circles, will show the
amounts of each element in the solution.
Note: At present, the Virtual Lab does not simulate gases.
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Removing Equipment
1. Click on the equipment you want to remove.
The name of the glassware or tool will become highlighted.

2. Press Delete or Backspace.
The equipment will disappear.
You can also right click on the object and select Remove from the
pop-up menu.
Note: At present, there is no Undo function. To clear a work area
without
removing equipment, see Adding a Workbench on page 16.
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Heating with a Bunsen Burner
1.

Click and drag the solution you want to heat on top of the Bunsen
burner until the glassware and burner overlap.
The flask will become centered above the flame, and the temperature will
begin to rise on the thermometer, on the right side of the workbench.

2.

To adjust the height of the flame, click on the Up or Down arrows.
Click and hold the Up arrow to increase the flame. Click and hold the
Down arrow to decrease the flame.
To remove heat, click and hold the Down arrow until the flame
disappears.
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Adjusting Thermal Properties
Note: Adjust thermal properties for cooling or for a constant temperature.

1. Right click on the solution for which you want to adjust thermal
properties.
The name of the flask will become highlighted and a pop-up menu
will be displayed.
Mac Users: You can access the menu by pressing the Control key
on your keyboard and single clicking the solution.

2. Drag the pointer down to the Thermal Properties option and
single click.
A Thermal Properties dialogue box will appear.

3. Type the new temperature for your solution and click Ok.
The dialogue box will disappear and the thermometer to the right
of the workbench will display the new temperature. The
solution will either cool or heat depending on the temperature of
its environment.
Select the Insulated from Surroundings option in the Thermal
Properties dialogue box for the solution to hold its new
temperature.
Note: The maximum temperature for aqueous solutions is 99º C. At
present, the Virtual Lab does not simulate boiling.
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Adding a Workbench
1. In the File menu, select New Workbench.
Another tab will appear on the bottom of your workbench area, but
your current workbench will stay visible, initially. Single click on the
new tab to make it the active workbench as shown on page 17.
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Selecting a Workbench
1. At the bottom of the workbench area, single click on a tab.
That workbench or problem description will move in front of the other tabs
and become the active workbench or display the problem description.
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Relabeling Glassware
Note:You may want to relabel a flask to reflect its new
contents each time you carry out a reaction.

1. Right click on the glassware you want to rename.
The name of the glassware will become highlighted and a pop-up
menu will be displayed.
Mac Users: You can access the Relabel option by pressing the F2
key on your keyboard.

2. Drag the pointer down and click on the Rename option.
A Relabel Solution dialogue box will appear.

3. Type the new label for the glassware and click Ok.
The dialogue box will disappear and the glassware will bear the
new label.
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Relabeling a Tab
Note: You may want to relabel your tabs when you are working on
several
different workbenches or have a problem description open.

1. Right click on the tab you want to rename.
A pop-up menu will be displayed.
Mac Users: You can access the Relabel option by pressing the F2
key on your keyboard.

2. Drag the pointer down and click on the Rename option.
A Relabel Tab dialogue box will appear.

3. Type the new label for the tab and click Ok.
The dialogue box will disappear and the tab will bear the new
label.
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Additional Help
1. Check the user guide online:
http://ir.chem.cmu.edu/irProject/applets/virtuallab/UserGuide.pdf
2. Ask your instructor or TA for the step-by-step demonstration
handout, or download it:
http://ir.chem.cmu.edu/irProject/applets/virtuallab/walkthrough.pdf
3. Email any questions or comments to:
feedback@ir.chem.cmu.edu
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About the IrYdium Project
The IrYdium Project develops educational software that
can be integrated smoothly into introductory chemistry courses
nationwide and used easily over the web. Where paper-andpencil homework typically emphasizes applying formulas—a
process that can become routine and disconnected from the
reality and fun of doing chemistry—interactive, simulation-based
exercises offer new ways to promote learning and motivation.
Interactive exercises can allow students to explore and reinforce
fundamental concepts in contexts that are increasingly
complex, realistic, and engaging. Our goal is to create flexible,
interactive learning environments where college and high school
students can approach chemistry more like practicing
scientists.
The Virtual Lab is intended as a flexible teaching and
learning tool. It can be used for in-class discussions, pre-lab
activities, or novel types of homework problems. We view
enhancing homework as a particularly important method of
increasing student learning and motivation. Also, by introducing
the Virtual Lab in homework assignments, we believe that
instructors can try this new technology-enhancing approach with
only minor adjustments in their course planning.
The IrYdium project began in 1997 and so far has
involved two faculty members, two software engineers, an
instructional designer, eleven undergraduate programmers, and
three technical writing interns. We are continuing to add new
features to the Virtual Lab and are now developing tools to help
instructors author interesting assignments that build on the
Virtual Lab and other simulations. We welcome your comments
and suggestions for future versions of our software at
feedback@ir.chem.cmu.edu.
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